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Inventory — Entering Bills for Received Inventory

COMPUTER PRACTICE

Step 1.

Step 2.
Step 3.

Step 4.

Step 5.

Select the Vendors menu and then select Enter Bills, Alternatively, click Enter Bills on
the Vendor section of the Home page.

Click Previous on the Enter Bills window to display Bill #4441,

Select the Expenses tab to record a $10.00 overcharge from the Vendor. Use the
Cost of Goods Sold account and the Overhead class to track the overcharge.
Alternately, you could record the overcharge to a Current Asset account call Due
from Vendors so that the error does not affect the Profit & Loss statement.

Click Recalculate to update the Amount Due field (see Figure 8-29). (Note that if you
Tab into the next line, a negative $10 will appear. You will have to clear that amount
in order to properly recalculate the Amount Due.)

Click Save & Close. Click Yes on the Recording Transaction message window.

Since the Bill in Figure 8-29 is $10.00 too much, contact the Vendor to discuss the
overage on the Bill. The Vendor will either issue you a credit, or if you have already
paid the Bifl, send you a refund check, The Vendor may also apply the overpayment
to your account to be applied to a future bill.

Depending upon the Vendor’s action, do one of the following:

¢ If the Vendor refunds your money, add the refund directly onto your next deposit. Code
the deposit to the Cost of Goods Sold account and the Overhead class (the account and
class you used when you recorded the overage on the bill).

e If the Vendor sends you a credit memo, enter a Bill Credit. Code the Bill Credit to the
Cost of Goods Sold account and Overhead class (the account and class you used when you

recorded the overage on the Bill).

i | ¥ Previous [ Net [ Save i%lind Gy History | W) Attach ) Pay bilt B B
@8 o e [#) 6 Recelved , | Vendor [ Transaction
— - i Ace Supply
Edi or
Summary
Phone 510-555-9646
Open balance 171.50
Crg:dt Lim_it 5,000,080
POs to be received Q
Expenses $1000 [Iems 8575 Recent Transactions QuickReport
Account Amount  Memo Customer:... Bilable? Class | 0407/ 15 Bk 85.75
50000 - Cost of Gaods Sold 10.00 |Record Overcharge Overhead - 04/07/15 Bk 85.75
3 01/20/15 Bl Pmt -Check 123,48
Instead of Cost of Goods Sold, you could use an
| asset account called Due from Vendors that
does not affect the company's Profit & Loss.
[ Geax spis | [ Recalasate ] ((saveaciose | [(gaveanew ) [ revet |

Figure 8-29 Record a Vendor overcharge in the Expenses tab
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Note: ' s :

Always use the same account when you recotd-the overcharge and the refund or
credit. In the example above, the Expenses tab of the Bill for Ace Supply increases
Cost of Goods Sold by $10.00 and the deposit or credit from the Vendor reduces
Cost of Goods Sold by the same amount. Alternatively, you could use an Other '
Current Asset account called Due from Vendors, as discussed above.

Adjusting Inventory

QuickBooks automatically adjusts Inventory each time you purchase or sell Inventory items.
However, it may be necessary to manually adjust Inventory after a physical count of your
Inventory, or in case of an increase or decrease in the value of your Inventory on hand. For
example, you might decrease the value of your Inventory if it has lost value due to new
technology trends.

Adjusting the Quantity of Inventory on Hand

COMPUTER PRACTKE

Step 1. Select the Vendors menu, select Inventory Activities, and then select Adjust
Quantity/Value on Hand. Alternatively, click the Inventory Activities icon on the
Home page and select Adjust Quantity/Value on Hand from the menu. QuickBooks
displays the window shown in Figure 8-31.

Step 2. If you need to, enter Quantity from the Adjustment Type field and press Tab.
Step 3. Enter 04/30/2015 in the Adjustment Date field and press Tab.
Step 4. Enter Inventory Variance in the Adjustment Account field and press Tab.

QuickBooks adjusts the account you enter into the Adjustment Account field to offset
the change in the Inventory Asset account balance. In this example, we are using
Inventory Variance, a Cost of Goods Sold account, but you can use whichever account
is best for your records.

Step 5. The Incorrie or Expense expected dialog box displays. Check the box next to Do not

.  The acoount spedfied for the adjustment is neither an income or an
& expense account. Mast people offset the change it inventory value o an
income account if itis a gain, or an expense account if itis & loss.

! Do not display this message in the future

o {

J

Figure 8-30 Income of Expense expected dialog box

Pt i

Note:

The dialog box displays because QuickBooks is looking for an expense account
to record the offsetting decrease in the Inventory asset. Although the entry can
be made tc an expense account (decrease in Inventory) or an income account
(increase in Inventory), many people find that offsetting Inventory variances to
the Cost of Goods Sold account (for either Inventory increases or decreases)
more accurately reflects the recording of variances.
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Inventory - Adjusting Inventory

Step 6.

“f‘"ﬁiq
¥ ofi

Enter 2015-T in the Ref No. field and press Tab twice to sklp the Customer: job field.

,ﬂ Prewous DNen | @ Atach

AdistmentType ' Quantity v

AdustmentDate  04/30/2015 ] Reference No. {2015-1

Adstyent Account | 54000 - Inventory Varia... Customer:Job T e
Class i Overhead -,
Find & Select ems... H
Ttem Description QtyonHand  New Quantity  Qty Difference |
Frame 5x7 Picture Frame - 5x7in. Metal ... 30 ] 2]s
|| Memo :Adjust Inventory for physical counts Total Value of Adjustment -4.30
i Number of Item Adjustments 1
{tem Info After Adjustment
Quantity on Hand 2
Avg Cost per Ttem 2,15
Value 60.20

Eggveadnse i [ guamj [

Figure 8-31 Adjust Quantity/Value on Hand window

Step 7. Enter Overhead in the Class field and press Tab.

Step 8. Enter Frame 5x7 in the /tem column and press Tab.

Step 9. Enter 28 in the New Quantity column and press Tab.
Notice that QuickBooks calculates the quantity difference (-2) in the Qty Difference
column. Also, notice that QuickBooks automatically calculates the Total Value of
Adjustment in the bottom right corner, QuickBooks Pro and Premier use the average
cost method to calculate this value. Look at the Inventory Valuation Detail Report later
in this chapter to see how the average cost changes each time you adjust Inventory
in this way.

Step 10. Enter Adjust Inventory for physical counts in the Memo field.

Step 11. To save the adjustment, click Save & New.

Adjusting the Value of Inventory

COMPUTER PRACTICE

With the Adjust Quantity/Value on Hand window displayed, follow these steps to record a

value adjustment to your inventory.

Step 1. Enter Quantity and Total Value from the Adjustment Type field and press Tab.
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h
i
[ ftem Descrp .
H [Frame 8x10 »[PictLre Frame - 810 inch Metal Frame

Meme[

tem Info After Adjustment

| Quantity onHend
& Avg Coafper Item
i Valuz

Figure 8 32 Chck on the Vaiue Adjustmentbox to changemventoryvaiue

Step 2. Confirm that 04/30/2015 is already selected in the Adjustment Date field. Press Tab.

Step 3. Confirm that Inventory Variance is already selected in the Adjustment Account field.

Step 4. Leave 2075-2 in the Ref. No. field.

Step 5. Leave the Customer:fob field blank.

Step 6. Enter Overhead in the Class field.

Step 7. Enter Frame 8x10 in the ftem column, Press Tab three times.

Step 8. Enter 735.00 in the New Value column on the Frame 8x10 line and press Tab. Notice
that QuickBooks calculates the Total Value of Adjustment.

Step 9. Enter Adjust Inventory Value of Frame 8x10 in the Memo field.

Step 10. Click Save & Close to save the adjustment.

QuickBooks will post the amount of this adjustment ($15.00) to the General Ledger.
Since this adjustment lowers the value of the Frame 8x10 item, it reduces the
average cost of each unit on hand. Therefore, the next time you sell a Frame 8x10,
QuickBooks will transfer the new (lower) average cost out of Inventory and into Cost
of Goods Sold.

The accounting behind the scenes: -

Inventory value ad]ustments always affect your Inventory Asset account. If the
Total Value of Adjustment is a positive number, the Inventory account increases. .' j
(debits) by that amount and the Adjustment account decreases; (credits) If the;
Total Value of Ad;ustment isa negative number, the debits and the cre(lits are
reversed, . :

Setting up Group Items

Sometimes, you sell items in bundles. For example, every time Academy Photography sells
three hours of services for retouching, it also includes a 5x7 metal frame. Academy
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Inventory — Setting up Group ltems

Photography uses Group Items to bundle products and/or services on sales forms. You may
also purchase items in a bundle from a Vendor, so setting up a Group Item may make the

purchasing process easier as well.

COMPUTER PRACTKE

Step 1. Click Items & Services on the Company section of the Home page, or select the Lists
menu and then select Item List.

Step 2. Select the Item button at the bottom of the /tem List window and select New.
Alternatively, press Ctrl+N.

Step 3. Select Group from the Type drop-down list and press Tab.

Step 4. Enter 5x7 Retouching in the Group Name/Number field and press Tab to advance to
the Description field.

Step 5. Enter Retouching photograph and placing in a 5x7 metal frame in the Description
field and press Tab.

Step 6. Click the Print items in group box (see Figure 8-33). Press Tab.

Step 7. On the first line at the bottom of the window, select Frame 5x7 from the /tem drop-

down list. Press Tab.

Step 8. Enter 7 in the Qty column and press Tab. The Qty column indicates how many of

each item is included in the Group.

Step 9. On the second line at the bottom of the window, select Retouching from the ftem

drop-down list. Press Tab.

Step 10.

Twe

¥hats the difference between & Group sod an Inventory Asse

Enter 3 in the Qty column. Press Tab.

: Gmup :Iumﬂdﬁmamnfrﬂvﬁdm;mi ————

Click this box to have your
printed Involces show the
detail of each ltem In the
group. The screen Involce
will always show sach
Individual Item In the group.

Frame 57 |Pichure Frame - 5x7 in, Metal Frame 1 -
Retouching  |Phote retouching services 3 [i

liem . Desaiption ety ]

List oach Hem that is
included with this Group. At
the right, Indicate the
quantities of each Item.
This Is ke defining a bill of
materlals for this Group
Item.

items within the ¢ roup. to -,calculate,-a t’atal prica forthe G Group. You can override
the price of each item within the Group directly on the sales form

In addition, the printed sales form will show the Group Item detail only if the
"Printitess. i1 group Box is chibcked: However; ye‘u wﬂl*aJWays see the items in this-
Group:bivthi screeri version of thegales form:

ri;‘(i

.,.,ﬁv-h 5 ‘ 3 ;‘- FA
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Step 11. Click OK to save the Group Item and then close the /tem List window.

Inventory Assemblies

QuickBooks Premier includes an Item Type called Inventory Assemblies which is quite useful if
you want to track individual Iferns and then group them into an assembly. Inventory Assembly
Items help to track Inventory that is created from raw materials that are themselves tracked as
Ttems.

The feature is similar to Groups, but it allows you to combine several Inventory Items into a
single Ifern. They are different from Group Ifems because the parts are removed from Inventory
as soon as an Inventory Assembly Item is assembled.

An Inventory Assembly is defined by specifying which components (must be Inventory Part,
Inventory Assembly, Non-inventory Part, Service, or Other Charge type items) are needed to
produce it. Essentially, you define the Bill of Materials for each Inventory Assembly Item when
you set up the item.

Inventory Reports

QuickBooks provides several reports for Inventory analysis, all of which are customizable in
ways similar to other reports.

For daily management of Inventory, use the Stock Status by Itern Report, the Stock Status by
Vendor Report, or the Inventory Valuation Summary Report. These reports give a quick overview
of Inventory counts, Inventory values, and pending orders.

For detailed research about transactions involving Inventory, use the Inventory Item
QuickReport or the Inventory Valuation Detail Report.

Inventory Item QuickReport

The Inventory Item QuickReport is useful for seeing all transactions involving an Inventory Hem.

{ cstonze Report | {stere Tengiote]_[wemore | pong ]
Dates ‘Custom > From |01/01/2015 [} To

Emai v
loy/2015 (@]
Academy Photography Inventory Chapter

Inventory Item QuickReport
As of April 30, 2015

e Type ¢ Date o Hum o Name ° Memo ¢ Oy o
ventory 25
Frame 5x7
On Hand As Of 42234/2014 25
b nvoice 0110942615 2015-1..  Mason, Bob Picture Frame - § x 7 Metal Frame 34
Bl OH072015 4431 Ace Supply Picture Frame - 5x7 in. Metal Frame S
Bl 040772015 4441 Ace Supply Picture Frame - 5x7 in. Metal Frame S
nvaice 043072015 2015-1... Perez, Jerry Picture Frame - Sx7 in. Metal Frame -2
Inventory Adjust 0413072018 201541 Frame £x7 inventery Adjustment -2
Tot On Hand As Of G4/30/2015 28

On Furchase Order Ag Of 1273172014

(=]

Purchase Order  D4/GTR2015 20151 Ace Supply Picture Frame - 5x7 in. Metal Frame ]

Tot On Purchase Order As Of 04/30£2018 0

Total lnvenlory 28
TOTAL As Of 04/30/2015 —_28

Figure 8-34 Inventory ftem QuickReport
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COMPUTER PRACTICE

Step 1. From the Home page, click the Inventory Activities icon and choose Inventory
Center.

Step 2. Click on the Frame 5x7 Item to select it in the left side of the Inventory Center.

Step 3. Click the QuickReport link from the right side of the Inventory Center.

Step 4. Set the from date to 07/01/2015 and the To date to 04/30/2015 and press Tab. The

QuickReport for the Frame 5x7 displays (see Figure 8-34).

Step 5. Close the report by clicking the close box (Eiﬁl) in the upper right corner of the
window. Leave the Inventory Center open.

Inventory Stock Status by Iltem Report

The Stock Status by Item Report is useful for getting a quick snapshot of each Inventory part, as
well as the number of units on hand and on order, In addition, this report gives you
information about your Inventory turnover, showing a column for sales per week.

COMPUTER PRACTCE

Step 1. Click the Stock Status link on the right side of the Inventory Center. Alternatively,
select the Reports menu, select Inventory, and then select Inventory Stock Status
by Item.

Step 2. Set the From date to 01/01/2015 and the To date to 04/30/2015 and press Tab. The
Inventory Stock Status by [tem report displays (see Figure 8-35).

: From wo;m:sfjf Tolov/nis ]
Academy Photography Inventory Chapter

Inventory Stock Status by ltem )
January theough April 2015 H

+ item Description » Pref Vendor « Reorder Pt ¢ _OnHand - On Sales Ordar « Avaliable oQrder s _OnPO o NextDeliv o SafesAipek ¢
faventory

Carmera SR32 ) Supra Digital Came... ] [ 9 ] 014 :
Case Comera and Lens ... 24 [ 24 0 3] !
Frame 5x7 Piciure Frame - Sx... % 28 [ 28 L] 03 s
Frame3xt0  Picture Frams - Gx..  Ace Supply -] 30 [ 3 2 [} g
Lens Supra Zoom Lens 7 1] 7 i 0.4

L i

Click No if you are prompted to memorize the report.

Inventory Stock Status by Vendor Report

The Stock Status by Vendor Report gives you information about your Inventory parts, including
how many are on hand, and how many are on order. This Report is sorted by the Preferred
Vendor field in the item.

COMPUTER PRACTICE

Step 1. Select the Reports menu, select Inventory, and then select Inventory Stock Status
i ¥ by Vendor.
s Step 2. Set the from date to 07/01/2015 and the To date to 04/30/2015 and press Tab. The

Inventory Stock Status by Vendor Report displays (see Figure 8-36).
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v Fon U TosvmmsiE
PO - ¥ Chapter

Inventory Stock Status by Vendor
January through April 2015

> nem Descrption +feorder Ml +_OnHand + O Sales Order + Avsksble +Ordes + _ONPO_ + BextObly » Swoniyeske |
Are Supoly
Frame Exid P Pickuss Frame - Sx10 0. beewsl -] ® [] ' ) THE
Total Ace Supply ® ] » 4 ©
Mo vendor
Camers SR32  Supr Diplat Camers SA3Z H [} [ ° 01
Case Coammca and Lens High Impact. E2 [] 24 a 01
Frame BaT  PokreFrame -£x7 n MetaF_ ) % [] [ ¢3 f
Lans Supra ZoemLent 7 2 z ' ]
Totat W vendor 7 [] a 08 E

Figuré 3-36 Inventory Stock § tatus by'Vendc:)f Répdrt

Step 3, To close the report, click the close box (B.]) at the top right corner of the window,
Click No if you are prompted to memorize the report.

Inventory Valuation Reports

The Inventory Valuation Summary Report gives you information about the value of your
Inventory items on a certain date. This report shows ecach item in Inventory, the quantity on
hand, the average cost, and the retail value of each item.

COMPUTER PRACTICE

Step 1, Click the Inventory Valuation Summary link on the right side of the Inventory
Center. Alternatively, select the Reports menu, select Inventory, and then setect

Inventory Valuation Summary.
Step 2. Set the Date field to 04/30/2015 and press Tab (see Figure 8-37).

it

o Yoort. Y ot ] Ciport ] | P egr 1. Rk |
Detes  cusctom _w owxsws ]
Academy Photography Inventory Chapler
Inventory Valuation Summary
As of April 34, 215

+ Mem P ¢ Onitand « Avglost + AsaetVelye + % of Tot Ageet + Salea Price + RetallVslue + % of ToiRetsll +
inventory

Camers SR32 b Supn Digtal Came . 9 450.00 4,850.00 B1.2% £95.99 g3 519% 4
Casze Camere ord Leny .. F AR 1.080.00 183% 0y L9 178%
Frame 8a7 Piclure Freme - Sx _ 28 FAL 8070 9% 595 18772 158%
Frame 8xil  Picturs Frame - Bx 2 456 135.00 20% 998 28370 27%
Lens Supra Zoom Lene I 0459 1,284 .53 188% 32483 227483 208%
Tatal Invantory B3 bAz013 400 0% 10,625 42 100 0%
TOTAL 58 5,620.13 Ho.0% 10426.02 100.0%

ngure 8-37 Inventory Valuation Summary report

Step 3. To close the report, click the close box (Xl at the top right corner of the window.
Click No if you are prompted to memorize the report.

Review Questions

Select the best answei(s) for each of the following:

1. If your Vendor ships more than you ordered on a Purchase Order (an overshipment),
which of the following actions would not be appropriate?

a)  You could refuse the extra shipment and send it back to the Vendor without
recording anything in QuickBooks.

b)  You could receive the extra shipment using an Inventory Adjustment transaction.

¢)  You could receive the extra shipment into Inventory and keep it (and pay for it).

d)  You could receive the extra shipment into Inventory, and then send it back and
record a Bill Credit in QuickBooks.
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2. When setting up a Group Item, where do you enter the sales price?

a)  Enter the price in the Sales Price field.

b)  Enter the price in the Item Pricing list.

Q) The Group Item does not include a Sales Price field.
d)  Enter the price in the Sef Price window,

3. To activate QuickBooks Inventory:

a) Select the File menu and then select Preferences.

b) Select Purchases - Vendors.

¢)  Consult your accountant to determine the proper Inventory valuation method.

d)  Select the Edit menu, then select Preferences, then click on the Items &
Inventory Preference and then click the Company Preferences tab. Finally, click
on the option that activates Inventory.

4. The Inventory asset account:

a)  Tracks open Purchase Orders of Inventory items.
b)  Decreases when Inventory is purchased.

c) Increases when Inventory is sold.

d) Increases when Inventory is purchased.

5. In QuickBooks Pro and Premier, Inventory can do all of the following except:

a)  Provide reports on the status of each item in Inventory including how many are
on hand and how many are on order.

b)  Use the LIFO or FIFO method of determining Inventory cost.

¢} Calculate gross profit on Inventory sold.

d}  Track the open Purchase Orders for every Inventory item.

Inventory Problem 1

APPLYING YOUR KNOWLEDGE

I Restore the Inventory-12Problem1.QBM file.

1. Create new Inventory Items in the [tem List with the following data.

# Item Type Inventory Part
Item Name Frame 4x6 Black
Purchase Description Picture Frame - 4x6 Black
] Cost $4.95
f COGS Account Cost of Goods Sold
Preferred Vendor Leave blank
¥ sales Description Picture Frame - 4x6 Black
W Price $9.99

§ Tax Code Tax
fl income Account Sales
¥ Asset Account Inventory Asset
B Reorder Point 25
A Qty on Hand Leave zero
Total Value Leave zero
Leave current date
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Item Type

Inventory Part

8 Item Name

Frame 4x6 White

§ Purchase Description

Picture Frame - 4x6 White

gl Cost

$4.49

§ COGS Account

Cost of Goods Sold

¥ Preferred Vendor

Leave blank

3 Sales Description

Picture Frame - 4x6 White

¥ Price

$8.99

§ Tax Code

Tax

¥ Income Account

Sales

§l Asset Account

Inventory Asset

8 Reorder Point

25

& Qty on Hand

Leave zero

d Total Value

Leave zero

Jasof

_ Leae current date

2. Create Purchase Order #2015-1 dated 04/06/2015 to Ace Supply using the Walnut Creek
Class for 10-Frame 5x7, 40-Frame 4x6 Black, and 40-Frame 4x6 White. Leave the Ship To
drop-down field at the top blank. The total PO amount is $399.10. Print the Purchase
Order on blank paper.

3. Record the transactions below. On these transactions, unless you're told differently,
keep all defaults on transactions for Date, prices, and Sales Tax.

April 10, 2015

April 13, 2015

April 17, 2015

April 20, 2015

April 20, 2015

April 30, 2015

Create an Item Receipt for 10-Frame 5x7, 15-Frame 4x6 Black, and
20-Frame 4x6 White from Ace Supply against PC #2015-1. The
product came without a bill, but the packing slip number was
#3883. The total Itern Receipt amount is $185.55.

Create an Item Receipt for the remaining items from Ace Supply
against PO #2015-1. The product came without a bill, but the
packing slip number was #7622, The total Item Receipt amount is
$213.55.

Create Invoice #2015-106 to Jerry Perez for 5-Frame 5x7 (use list
price). Use the Walnut Creek Class. The total Invoice amount is
$32.42.

Received bill for Item Receipt #3883 from Ace Supply. Additional
$8.50 delivery charges were added to the bill. Use the Expenses tab
on the bill to record delivery charges (coded to Postage and Delivery
expense) and allocate the cost to the Walnut Creek Class. The total
Bill amount is $194.05, (Hint; Use the Recalculate button if
necessary to adjust the Amount Due.)

Received bill for Item Receipt #7622 from Ace Supply. The total Bill
amount is $213.55.

Enter an Inventory Adjustment for a Frame 5x7 item. Use the
Inventory Variance account and the Walnut Creek class to record the
adjustment. Inventory Adjustment Reference # 2015-101. Quantity on
hand is 26. The total Value of Adjustment is -$2.15.
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4. Create and print the following reports:

a) Frame 5x7 Item QuickReport with the Dates field set to All
b) Inventory Stock Status by Item for 01/01/2015 through 04/30/2015
¢)  Inventory Valuation Summary as of 04/30/2015

Inventory — Review Questions




